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คํานํา  

      Pilot project การจัดทาํหนังสืออิเล็กทรอนิกสในโครงการหนังสือหายากออนไลน : E-text  ของ
ศูนยวิทยทรัพยากร เปนโครงการริเร่ิมการจัดทําหนังสืออิเล็กทรอนิกสดวยการใชกลองดิจิทัล           
เพื่อถายทอดประสบการณการทํางานและผลงานของโครงการฯใหเปนที่ประจักษ ขาพเจาในฐานะ
ผูปฏิบัติงานไดรวบรวมขั้นตอนงานและผลสําเร็จแหงงานจัดทําเปนขอเขียนสองภาค ภาคที่ 1 คือ การ
จัดทําหนังสืออิเล็กทรอนิกสในโครงการ หนังสือหายากออนไลน : E-text   เลมนี้ และภาคที ่2 คือ 
ผลงานภาพหนังสือหายากอเิล็กทรอนิกส  และนอกจากการนําเสนอในแบบสิ่งพิมพแลว ผูสนใจ
สามารถศึกษาจากผลงานที่เผยแพรทางอิเล็กทรอนิกสใน CUIR ไดดวย  

เมื่องานถายภาพริเร่ิมความคิดในการใชกลองดิจิทัลถายทาํหนังสือหายากของหอสมุดกลาง 
ศูนยวิทยทรัพยากรนั้น การใชกลองถายภาพถายทําหนังสือยังไมใชวิธีการที่ใชกันแพรหลาย สวนใหญ
นิยมใชการกวาดสัญญาณภาพเปนไฟล ดวยเครื่องกราดสญัญาณ (flatbed scanner) หากเนื่องดวย
ทรัพยากรสารสนเทศของหอสมุดกลางเปนทรัพยสินทางปญญาที่มีทั้งคุณคาและราคา ปฏิบัติการใดกับ
ตัวเลมหนังสือควรตองใชความระมัดระวังเปนอยางยิ่งทีจ่ะไมทํารายลักษณะทางกายภาพ การใชกลอง
ถายภาพจึงเปนทางเลือกที่ดทีี่สุด แตสําหรบัผูปฏิบัติงานแลว งานนี้นับเปนงานที่ทาทายความสามารถ 

      เนื่องจากโครงการนี้เปนโครงการนํารองเพื่อนําการผลิตหนังสืออิเล็กทรอนิกสดวยการ
ถายภาพ  ระหวางดําเนนิการชางภาพตองใชทั้งศาสตรและศิลปเพื่อใหงานบรรลุผลตามวัตถุประสงค 
เร่ิมจากการประสานงานที่ดีระหวางทีมงาน (ทั้งศูนยโสตทัศนศึกษากลาง และหอสมดุกลาง) การ
ประมวลประสบการณและความรูในงานถายภาพที่มีอยูและที่ตองศึกษาเพิ่มเติม มาดัดแปลงเครื่องมือ
และวิธีการที่เหมาะสมเพื่อใหไดผลงานภาพที่ดีที่สุด  ตลอดขั้นตอนการเตรียมงาน การปฏิบัติงานและ
การเรียงรอยผลงานใหเปนชิน้งานพรอมบริการนั้น ลวนเปนผลจากวิริยะ อุตสาหะ และความมุงมัน่ของ
ผูรวมงานทุกคน ผลสําเร็จแหงงานไมเพียงเปนความภูมใิจของผูปฏิบัติงานเทานั้น  โครงการนี้ยังเปน
ตนแบบเพื่อการศึกษาสําหรบังานหนังสืออิเล็กทรอนิกสสําหรับองคกร/สถาบันอื่นๆ ดวย  

          ประโยชนอันพึงเกดิจากความรูของผลงานนี้ ขอมอบแดผูปฏิบัติงานโครงการฯทุกทาน รวมทั้ง
ศูนยวิทยทรัพยากรที่เปดโอกาสใหผูปฏิบัติงานไดใชความรูความสามารถสรางผลงานไดเต็มที ่
ขอบกพรองใดใดในงานนี ้ขาพเจาขอนอมรับเพื่อปรับปรงุแกไขใหงานสมบูรณตอไป         
          ชัชวาล   ศรีสละ 



สารบัญ 
 

                                                                                                                                                             หนา 
 
การจัดทําหนังสืออิเล็กทรอนิกส        1 

ตัวอยางผลงานหนังสืออิเล็กทรอนิกสเร่ือง มัทนะพาธา    12  
การดําเนนิงาน การจัดทําหนังสืออิเล็กทรอนิกส      21 

ขั้นตอนเตรียมการเพื่อการถายภาพ      21 
การใชอุปกรณ เครื่องมือและวิธีการปฏิบัติงานการถายภาพหนังสือหายาก  21 

ขั้นตอนการถายภาพ         33 
เทคนิคเพื่อความคมชัดของการถายภาพหนงัสือหายาก    35 
ขั้นตอนการปรับแตงภาพใหสวยงามกอนนําสง     35 

อภิปรายผลโครงการและขอเสนอแนะ       39 
ขอเสนอแนะเพื่อการดําเนนิการขั้นตอไปของโครงการ     42 
งานทดลองจัดทําหนงัสือหายากอิเล็กทรอนิกสประเภทตนฉบับตัวเขยีน-   43 
สมุดไทยดําไทยขาวเรื่อง อนิรุทธ คําฉันท 
ภาคผนวกตนแบบการสรางขอมูลอิเล็กทรอนิกสของคัมภีรโบราณ (Bible)   47 
บรรณานุกรม          53 
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การจัดทําหนังสืออิเล็กทรอนิกสในโครงการ หนังสือหายากออนไลน : E Text  
ภาค 1 การจัดทําโครงการฯ 

 
ชัชวาล ศรีสละ 

 
 สําหรับบรรณารักษและ/หรือประชาคมหองสมุดน้ัน เม่ือเอยถึงเรื่องราวของหนังสือหายาก 
ความคิดจะมุงไปที่เรื่องการอนุรักษเปนลําดับแรก เน่ืองจากในวงวิชาชีพบรรณารักษทุกคนทราบดีวา 
หนังสือหายากเปนทรัพยากรสารนิเทศที่มีคาในเชิงประวัติศาสตร  สวนใหญเปนหนังสือที่มีอายุมาก สภาพ
หนังสือไมพรอมใหบริการช้ันเปด  ดังน้ันหนวยงานบริการสารนิเทศสวนใหญที่มีหนังสือหายากใน
ความหมายนี้ จึงมีการจัดการสารนิเทศแบบชั้นปดและเนนที่การอนุรักษ/รักษาหรือคงสภาพสารนิเทศ
เหลาน้ัน  

เม่ือกระบวนการทางอิเล็กทรอนิกสเขามามบีทบาทในงานหองสมุด หนวยงานบริการสารนิเทศ
หลายแหงเร่ิมใชการแปลงสือ่เปนดิจิทัล (digitization) เพ่ือการใหบริการสารนิเทศ และการอนุรักษ  ในป 
2546 หอสมุดกลางและศูนยโสตทัศนศึกษา ศูนยวิทยทรัพยากร โดยงานถายภาพไดเริ่มโครงการนํารองใน
การอนุรักษหนังสือเกาหรือหนังสือหายากที่จัดเก็บที่หอสมุดกลาง โดยใชการถายภาพดิจิทัลถายภาพ
หนังสือหายากเหลาน้ันเพื่อการคงสภาพตวัเลม และใหใชบริการในรูปไฟลดิจิทัลแทน 
 งานถายภาพซึ่งเปนผูรับผิดชอบโดยตรงในกระบวนการทางเทคนิค มีหนาที่ในการประสานงาน
การถายภาพตั้งแตเริ่มโครงการ โดยรับผิดชอบการถายภาพหนังสือหายาก ซ่ึงเปนหนังสือเกา สภาพรูปเลม
ไมสามารถใชการสแกนภาพได เพราะจะทําใหหนังสือชํารุดเสียหาย หนังสือเกาหรือหนังสือหายาก
เหลาน้ันตองใชความพิถีพิถัน คอยพลิกทีละหนา จัดตนฉบับเลมหนังสือใหอยูในตําแหนงที่จะถายไดภาพที่
คมชัดที่สุดเทาที่จะเปนไปได และใหมีความสม่ําเสมอเทากันทุกหนา ทุกบทและทุกตัวอักษร ลักษณะการ
จัดถายเชนน้ีสอดคลองกับการจัดถายงานภาพตนฉบับ วัสดุ ส่ิงของ ปฏิบัติและรับผิดชอบอยู การดําเนินงาน
ทั้งหมดตองมีการทดลองทําเปนโครงการนํารอง (pilot project)  รวมหนังสือหายาก จํานวน 28 เลม และ
รายงานกิจการของจุฬาลงกรณมหาวิทยาลยั ป 2540 และ 2541 (2 เลม) จากนั้นไดนําขึ้น website ของศูนย
วิทยทรัพยากร เปนบริการหนังสือหายากออนไลน  
 ในการดําเนินงานตามโครงการนี้ งานถายภาพถายภาพจากหนังสือหายากที่ใหบริการในหอง
หนังสือหายากของหอสมุดกลาง รวม 30  เลม (2990 หนา) ผูสนใจศึกษาขอมูลเพ่ิมเติมเกี่ยวกับหนังสือหา
ยากของหอสมุดกลาง สามารถเขาดูไดที่  http://www.car.chula.ac.th/web/form/resources/ หรือสามารถ
ติดตอใชบริการเลมจริงไดที่หองหนังสือหายาก หอสมุดกลาง ศูนยวิทยทรัพยากรช้ัน 6 
           สําหรับรายละเอียดทางบรรณานุกรมของผลงานเหลาน้ีปรากฏตามเอกสารในหนาตอไป 
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TITLE: ศิลปกรรมงานสะสมของจุฬาลงกรณมหาวิทยาลัย 
AUTHOR: นิทรรศการศิลปกรรมงานสะสมของจุฬาลงกรณมหาวิทยาลัย 
(2538 : จุฬาลงกรณมหาวิทยาลัย)  
YEAR: 2538, 83 หนา 
NOTE: ณ หอศิลปวิทยนิทรรศน สถาบันวิทยบริการ จุฬาลงกรณ
มหาวิทยาลัย 26 มีนาคม - 25 เมษายน 2538 

 
 
 
 

TITLE: ครูเหม เวชกร 
AUTHOR: นิทรรศการภาพวาดวิจิตร ครูเหม เวชกร (2539 : 
จุฬาลงกรณมหาวิทยาลัย) 
YEAR: 2539, 24 หนา 
NOTE: ณ หอศิลปวิทยนิทรรศน สถาบันวิทยบริการ จุฬาลงกรณ
มหาวิทยาลัย 21 มีนาคม - 26 เมษายน 2539 

 
 
 
 

 

TITLE: กันปวย 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๖, ๑๑๗ หนา 
NOTE: พิมพในงานพระราชทานเพลิงศพ มหาเสวกตรี พระยาราชอักษร 
(ใช อัศวรักษ) 

 
 
 

 
TITLE: กุศโลบาย 
AUTHOR: มารแชล, รอเบอรต 
YEAR: ๒๕__, ๑๖๘ หนา 
NOTE: แปลโดย ศรีอยุธยา (พระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว) 
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TITLE: ขอมดําดิน แถลงเรื่องตามตํานาน และสันนิษฐานโบราณคดี
และเปนบทกลอนลคร 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕__, ๔๓ หนา 

 
 

 
 
 
 

TITLE: โคลงภาพพระราชพงศาวดาร 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๑๓, ๑๐๗ หนา 
NOTE: พิมพเปนอนุสรณในงานพระราชทานเพลิงศพ หมอมจันทร เท
วกุล ณ เมรุวัดธาตุทอง 1 มิ.ย. 2513 

 
 
 
 
 

TITLE: โคลงสุภาษิตเจานาย พระราชนิพนธและพระนิพนธทรงเมื่อใน
รัชกาลท่ี ๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๑๓๒ หนา 

 
 
 

 
 
 
TITLE: โคลงสุภาษิตใหม 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๕, ๑๓๒ หนา 
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TITLE: เงาะปา 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๒๕, ๓๒ หนา 
NOTE: ภาพและคําบรรยายโดย เหม เวชกร 

 
 

 
 

TITLE: ชุมนุมพระราชนิพนธในรัชกาลที่ ๕ ภาคปกิณณกะ ภาค ๑ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๙๓, ๔๙ หนา 
NOTE: พระเจาบรมวงศเธอ พระองคเจาวาปบุษบากร โปรดใหพิมพใน
งานพระราชทานเพลิงพระศพ พระเจาบรมวงศเธอ พระองคเจา 
ประภาพรรณพิไลย ณ พระเมรุทองสนามหลวง 
 

 
 
 
 
 

TITLE: เทศนาพระราชประวัติ พระบาทสมเด็จพระจอมเกลาเจาอยูหัว 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๐๕, ๑๖๐ หนา 
NOTE: พิมพเปนที่ระลึก ในงานประดิษฐาน พระบรมรูป พระบาทสมเด็จ
พระจอมเกลา บนพระนครคีรี จังหวัดเพชรบุรี พ.ศ.๒๕๐๕ 
 
 
 

 

 

 
 
TITLE: ธรรมเนียมราชตระกูลในกรุงสยาม 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๐๑, ๖๔ หนา 
NOTE: คณะพระภิกษุสามเณร วัดบวรนิเวศวิหาร พิมพอุทิศถวายสวน
กุศล พระเจาบรมวงศเธอ พระองคเจาอาทรทิพยนิภา ในงานพระราชทาน
เพลิงพระศพ ณ พระเมรุ สุสานหลวง วันเทพศิรินทราวาส วันท่ี ๕ 
กรกฎาคม ๒๕๐๑ 
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TITLE: ตํานานชาติฮั่น 
AUTHOR: มอรแลนด, อาเทอร 
YEAR: ๒๕__, ๑ เลม (ไมมีเลขหนา) 
NOTE: แปลโดย รามจติติ (พระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว) 

 
 
 
 
 

 
TITLE: บทลครเรื่องเงาะปา 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๑๓๕ หนา  

 
 
 
 
 

 
TITLE: ประชุมโคลงสุภาษิตพระราชนิพนธในรัชกาลที่ ๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๖๐ หนา  

 

 
 
 
 
 
TITLE: ประเพณีทําบุญวันเกิด 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๘, ๕, ๗๐ หนา  
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TITLE: พระบรมราชาธิบายเรื่องเครื่องราชอิศริยาภรณของกรุงสยาม 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๒๓, ๑๕ หนา  

 
 

 
 

 
 
TITLE: พระบรมราชาธิบายเรื่องสามัคค ี
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๘๙, ๒๒ หนา 

 
 

 
 
 
 
 

 
 
 
TITLE: พระบรมราโชวาทตักเตือนขาราชการในพระราชสํานักเรื่อง
ประพฤติผิดพระราชนิยมและกฎหมายแผนดิน 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๑๒ หนา  

 

 
 
 
 
TITLE: พระบรมราโชวาทพระบาทสมเด็จพระรามาธิบดีท่ี 6 พระราชทาน
แดทหารในกองทัพบกสยาม 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๙๒ หนา 
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TITLE: พระบรมราโชวาทเสือปา 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๒, ๑๕๒ หนา 

 
 
 
 
 

 
 
TITLE: พระราชดํารัสในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัว 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๘, ๒๗๒ หนา 

 
 
 
 

TITLE: พระราชดํารัสในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัวทรง
แถลงพระบรมราชาธิบายแกไขการปกครองแผนดิน 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๐, ๖๔ หนา 
NOTE: พิมพพระราชทานแจกเนื่องในงานทรงบําเพ็ญพระราชกุศลสนอง
พระเดชพระคุณพระบาทสมเด็จพระพุทธเจาหลวง ในวันตรงกับเสด็จ
สวรรคต ท่ี ๒๓ ตุลาคม พ.ศ. ๒๔๗๐  
 

 
 

 

 
 
 
 
 
 
 
TITLE: พระราชดํารัสในพระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๒, ๓๒๙ หนา  
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TITLE: พระราชนิพนธคํานมัสการคุณานุคุณ 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๘, ๒๗ หนา  

 
 
 
 
 

TITLE: พระราชนิพนธในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัวทรง
วิจารณเรื่องพระราชพงศาวดารกับเรื่องราชประเพณีการต้ังพระมหาอุปราช
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๙, ก-ฆ, ๙๕ หนา 
NOTE: สมเด็จพระเจาอยูหัวรัชกาลท่ี ๗ โปรดใหตีพิมพแจกในงาน
พระราชทานเพลิงพระศพ พระเจาบรมวงศเธอ พระองคเจาอรพินทุเพญ
ภาคย ณ วันท่ี ๒ กุมภาพันธ พ.ศ. ๒๔๗๙ 
 
 
 
 

 
 
 
 
 

 

TITLE: พระรวง 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๑๑๗ หนา  

 

 
 
 
 
 
TITLE: ภาพฝพระหัดถชนิดภาพลอเสนหมึก 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๒๒ หนา 
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TITLE: ภาพฝพระหัดถชนิดภาพเสนขาด 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๖ หนา 

 
 
 
 
 

TITLE: มัทนะพาธา 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๗, ๑๔๖ หนา  
NOTE: ตํานานแหงดอกกุหลาบ 

 
 
 
 
 

 
TITLE: เมืองไทยจงต่ืนเถิด 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๘๑, ๗๘ หนา 

 
 
 

 
TITLE: เรื่องตามใจทาน 
AUTHOR: เช็คสเปยร, วิลเลียม 
YEAR: ๒๔__, ๑๗๑ หนา 
NOTE: สมเด็จพระรามาธิบดีศรีสินทรฯ พระมงกุฎเกลาเจาแผนดินสยาม 
ทรงแปลและประพันธเปนกาพยภาษาไทย 
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TITLE: เรื่องเที่ยวเมืองพระรวง 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๐, ๒๔๔ หนา  

 
 
 
 
 

TITLE: เรื่องพระราชพิธีพืชมงคลแลจรดพระนังคัลพระราชนิพนธรัชกาล
ที่๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๕, ๖๐ หนา  
NOTE: พิมพแจกในการแรกนาขวัญ เมื่อวันที่ ๘ พฤษภาคม พ.ศ. 
๒๔๖๕ 
 
 

 
 
 
 
 

TITLE: เวนิสวานิช 
AUTHOR: เชคสเปยร, วิลเลียม 
YEAR: ๒๔๕๙, ๑๘๖ หนา 
NOTE: แปลเปนกลอนโดย พระบาทสมเด็จพระรามาธิบดีศรีสินทรมหา
วชิราวุธ พระมงกุฎเกลาเจาอยูหัว 

 
 
 

TITLE: ศกุนตลา 
AUTHOR: กาลิทาส 
YEAR: ๒๕__, ๑๕๐ หนา 
NOTE: พระบาทสมเด็จพระปรเมนทรมหาวชิราวุธพระมงกุฏเกลา
เจาอยูหัวทรงพระราชนิพนธ ประกอบดวยคํานํา และอภิธานอธิบายศัพท 
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TITLE: สักระวานาหนาว 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๒๒ หนา 
NOTE: รวบรวมจากหนังสือพิมพ "ดุสิตสมิต" 

 
 
 
 
 

TITLE: หนังสือหลักราชการ 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๗__, ๔๔ หนา 
NOTE: พิมพพระราชทานแจกขาราชการในการพระราชพิธีตะรุษะ
สงกรานต 
 

 
 
 
 
 

 
 
TITLE: รายงานกิจการจฬุาลงกรณมหาวิทยาลัยป2540 

 

 
 
 
 
 
 
 
TITLE: รายงานกิจการจฬุาลงกรณมหาวิทยาลัยป2541 
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ตัวอยางผลงานหนังสืออิเล็กทรอนิกส 
 

เรื่อง มัทนะพาธา 
หรือ 

ตํานานแหงดอกกุหลาบ 
ละครพูดคําฉันท ๕ องก 

สมเด็จพระรามาธิบดีศรีสินทรมหาวชิราวุธทรงพระราชนิพนธ 
พ.ศ. ๒๔๖๗  (จํานวน ๙ หนา) 
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การดําเนินงาน การจัดทําหนังสืออิเล็กทรอนิกสในโครงการ หนังสือหายากออนไลน : E Text 
 
เร่ิมจากการคัดเลือกหนังสือเพ่ือการถายภาพนั้น บรรณารักษจะคัดเลือกหนังสือหายากเลมที่มี

คุณภาพดี และชางภาพตองสํารวจอีกคร้ังวาสภาพหนังสือสมบูรณไหม?  มีหนาครบทุกหนา และตองวาง
แผนการถายภาพ บางเลม หนาหนังสือมีเฉพาะหนาขวา  บางเลมมีทั้ง 2 หนา บางเลมเริ่มตนดวยเลขหนา 1, 
2, 3 บาง เปนอักษร ก ข ค บาง บางเลมมหีนาพับซอนขยาย เชน หนาตารางหรือกราฟ หรือแผนท่ี ซ่ึงทําให
ปฏิบัติงานไดยาก ส่ิงที่ควรระวังที่สุดคือ สภาพที่หนังสือหายากที่มีอายุเกาและเสื่อมตามสภาพใชงาน  และ/
หรือกรอบมาก ๆ เม่ือชางภาพถายไปและพลิกไปทีละหนาแผนกระดาษในหนังสืออาจจะกรอบและหัก
ชํารุดเสียหายได 
 
ขั้นตอนเตรียมการเพื่อการถายภาพ 
 วิธีการใหไดมาซึ่งภาพดังกลาว ชางภาพเรียกวา เปนการถายกอปปภาพ  ภาพท่ีจะถายกอปปอาจจะ
เปนภาพจากหนังสือ ภาพเขียน ตัวหนังสือ ภาพลายเสน ฯลฯ  ก็ได ในการถายกอปปภาพดังกลาว จะขอ
อธิบายเคร่ืองมือทางการถายภาพเพ่ือใหเขาใจกระบวนการทํางานได  ดังตอไปนี้ 

1. กลองและเลนสถายใกล 
2. แทนกอปปภาพ (Copy stand) 
3. ไฟสองสวาง 
4. สายล่ันไกชัตเตอร  
5. ขาตั้งกลอง 
6. กระดาษสีดํา                
7. กระจกดาน (Matte mirror) 

 
 
การใชอุปกรณ เครื่องมือและวิธีการปฏิบัติงานการถายภาพหนังสือหายาก 
 
1. กลองและเลนสถายใกล 
 เน่ืองจากปจจบุันกลองดิจิทัลมีบทบาทในงานถายภาพมากเพราะใชงานไดสะดวก (เม่ือเทียบกับ
การอนุรักษในสมัยกอนโดยใชไมโครฟลม) กลองดิจิทัลมีหลายรูปแบบและมีใหเลือกหลายรุนหลายขนาด
ในการถายภาพหนังสือหายากทีละหนา ขอแนะนําในการเตรียมกลองดิจิทัลในลักษณะของงานอนุรักษ ควร 
เลือกชนิดกลองดิจิทัลชนิดที่สามารถถอดเปลี่ยนเลนสได เน่ืองจากตองใชเลนส แมคโคร ซึ่งเปนเลนสท่ีมี
ความสามารถในการถายภาพระยะใกลกับวัตถุมากๆ ได เพ่ือใหไดภาพถายที่คมชัดทุกระนาบองศา  
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กลองดิจิทัล มาจากคาํภาษาอังกฤษวา Digital single lens reflex (DSLR) คือ กลองดิจิทัล สะทอนภาพแบบ
เลนสเด่ียว กลองแบบน้ี มีหลายฟอรแมตดวยกัน ฟอรแมตที่นิยมโดยทั่วไปคือ 35 DSLR และฟอรแมตนี้ก็
จะมีกลุมเลนสใหเลือกใชมากมาย ทั้งเลนสปกติ เลนสมุมกวาง เลนสดึงภาพ (Zoom) เลนสถายภาพ
ระยะไกลรวมทั้งเลนสแมคโครดวย 
กลองที่งานถายภาพเลือกใช คือ กลอง NIKON  รุน D100  เปนกลองดิจิทัลขนาดฟอรแมต 35 DSLR ให
ไฟลไดหลายรูปแบบ  SPEC กลองดิจิทัลรุน NIKON  D 100 ดังกลาวน้ี มีนํ้าหนักเบา  มีความทนทาน 
คลองตัว มีความเหมาะสมในการใชงาน   ไฟลภาพจากกลองจะเปนไฟลภาพขนาดใหญ (มากถึง  6.31  ลาน
พิกเซล) และเปนไฟลภาพ Jpeg  และ Tiff  เม่ือถายโอนไปยังคอมพิวเตอร มีคุณภาพในระดับกลองโปร   
Nikon  D 100 ใช  CCD  ขนาด 23.7 x 15.6 มม.   มีคาไดนามิกเรนจกวาง  เก็บรายละเอียดไดดี     ทั้งสีที่มี
คอนทราสตและความคมชัด  กลอง Nikon  D 100   มีโหมดสีใหเลือก 3 แบบ ตามความเหมาะสมของงาน 
คือ  1) Mode  sRGB   ชวงของโทนสีกวาง  สีดูเปนธรรมชาติ  สีผิวของบุคคล  เหมาะงานถายภาพบุคคล    
      2) Mode  Adobe  RGB  ชวงกวางสีมากที่สุด  ไฟลภาพสีมีคุณภาพสูง  สําหรับงานถายภาพเชิงพาณิชย  
เชน สินคาหรือจัด Subject   และ  prop  ใน Studio  และ     
      3) Mode   sRGB  Optimised  ความอิ่มตัวของสีสูงเปนพิเศษสําหรับถายภาพทิวทัศน  ธรรมชาติ  
 
รายละเอียดและคุณลักษณะกลองดิจิทัล  Nikon  D 100 
 กลองดิจิทัลมีความละเอียด  6.31  ลานพิกเซล,  ความไวแสงสูงสุด  ISO 200 – 6400,  จอ LCD  
ขนาด 1.8 น้ิว , นํ้าหนัก 730  กรัม, มีคุณลักษณะของกลอง  (Specification) ดังน้ี 
ความละเอียด 6.31 Mpixel 
ขนาดภาพสูงสุด 3008x2000 
ขนาดภาพเล็กสุด 1504x1000 
ขนาดเซ็นเซอร 23.7x15.5 mm 
เซนเซอร CCD 
ตัวคูณโฟกัส 1.5 
ซูมเลนส n/a 
ซูมดิจิทัล No 
ระบบโฟกัสอัตโนมัติ Yes  
ระบบแมนนวลโฟกัส Yes 
ความไวแสง auto,200-1600,3200,6400 
โหมด  Aperture  priority Yes  
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เลนสถายใกล 
 เลนสของกลอง NIKON มีใหเลือกมากมาย แตเลนสที่นํามาถายกอปปน้ัน  ควรเลือกใชเลนสแมค
โคร (MACRO LENS) เน่ืองจากเลนสแมคโครถูกออกแบบใหโฟกัสไดมากกวาเลนสปกติ ทําใหสามารถ
ถายภาพวัตถุที่มีขนาดเล็กมาก ๆได  ทําใหไดอัตราขยายสูงๆ  เลนสแมคโครจึงเหมาะสมในการนํามาถาย
กอปปภาพ โดยเฉพาะหนากระดาษหนังสือหายาก เพ่ือเก็บรายละเอียดของตัวหนังสือไดดี ย่ิงหากเปน
ตัวหนังสือที่มีวิธีพิมพแบบเกา ซ่ึงใชตัวบล็อกตะกั่วที่บางครั้งความคมชัดของหมึกพิมพบนตัวตะกั่วไม
สม่ําเสมอ  เลนสแมคโครที่มีคุณภาพจะเก็บรายละเอียดเหลาน้ีไดดีทีเดียว ดวยเหตุที่วาเลนสแมคโครมีคุณ
ลักษณะเฉพาะ คือ แมคโครนั้นหมายถึง การถายภาพวัตถุที่ Life size คือ 1: 1 น่ันคือ ไดภาพวัตถุที่
อัตราสวนของภาพในขนาดเทาจริง  อัตราสวน 1 :1 มีความหมายวา  สามารถถายภาพไดขนาดภาพในฟลม
เทากับขนาดของวัตถุ  สวนอัตราสวน  1 : 2  หมายถึง  ขนาดภาพในฟลมเทากับขนาดครึ่งหนึ่งของวัตถุ  (ใน
ปจจุบันคงกลาววา  ภาพบน  CCD  หรือภาพบน  CMOS)  เลนสแมคโครแท ๆ คุณภาพดี จะมีระยะโฟกัส
ใกลสุดมาก ๆ น่ันคือ  ระยะที่ 1:1 และ 1:2 (ในปจจุบันเลนสแมคโครรุนใหมมักทําระยะที่ 1:1)   

การประเมินในเรื่องของความคมชัดของการถายภาพตัวหนังสือในหนังสือหายากนั้น เลนสแมค
โคร 1:1 จะใหความคมชัด (ความชัดลึก) ที่ตื้นมาก (แตในระยะโฟกัสท่ีเจตนาใหชัดและชางภาพโฟกัสได
ชัดน้ัน จะมีความคมชัดมาก)  การเลือกจุด(ตําแหนง)โฟกัสในการใชงานเลนสแมคโคร จึงตองระมัดระวัง
มาก  การโฟกัสที่ผิดพลาดไปเล็กนอย จะทําใหจุดสําคญัเสียไป ตองระมัดระวังมากย่ิงข้ึนสําหรับหนังสือหา
ยาก  เพราะกระดาษแผน ๆ อยางที่เห็นวางายน้ัน หากระนาบโฟกัสไมไดมุมซายบนชัด  มุมลางขวากระเดิด 
ผลคือ ภาพไมโฟกัส  ผลงานก็จะไมมีคุณคาในการถนอมและเก็บรักษาอยางมีคุณคา (และไมอาจอางไดวา
เปนตนแบบงานอนุรักษ) 

 
เลนสซูมแมคโคร (Macro zoom lens)  

กลองดิจิทัล 35 DSLR นิยมใชเลนสซูมกันมากขึ้น เพราะใหความสะดวกและคลองตัว  ชางภาพ
สามารถปรับทางยาวโฟกัสของเลนส ใหมีคาทางยาวโฟกัสตามคาทีต่องการ ทําใหเลือกตัดสวนและ
ถายภาพไดอยางงายๆ ไมตองเสียเวลาถอดเลนสและเปล่ียนเลนส  เพราะเลนสซูมจะมีชุดของเลนสอยูในตัว
กลอง  เลนสซูมแมคโคร เชน เลนส 28-105 มม. จะมีการถายภาพแบบแมคโครเขามาดวย ทําใหเลนสเหลาน้ี
เปนเลนสอเนกประสงค แตถือวาไมใช แมคโครแท เปนแมคโครเทียม (Psudo macrolens)  เลนสแมค
โครเทียม มีขอระวังในการใชงานที่วา นอกจากตัวเลนสมักจะใหญและหนักแลว ในการออกแบบตัวเลนส
หน่ึงตัวใหใชงานได อเนกประสงคน้ัน ตองเปนเลนสซูมที่มีชิ้นเลนสหลายชิ้น ทําใหตัวเลนส(กินแสง) 
สูญเสียแสงไปมาก  ภาพท่ีไดจึงมักไมคอยคมชัด สีก็อาจไมสดใสอยางที่ควรจะเปน  เลนสแมคโครซูม
ดังกลาวน้ี  เปนสวนหน่ึงของจุดขายของผูผลิตเลนสโดยเฉพาะผูผลิตเลนสอิสระมักจะชอบผลิตเลนสซูมให
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มี Mode แมคโครขึ้นมา  ซ่ึงมักมีกําลังขยายอัตราสวน 1 : 4  หมายถึง ขนาดของภาพในฟลมจะเปนขนาด ¼ 
ของขนาดวัตถุที่ถายนั้น  และเมื่อสังเกตภาพขยายใกล ๆ เม่ือเทียบกับเลนสแมคโครแท ๆ จะพบวา  ภาพที่
ไดมีอาการขอบภาพมืดและเกิดการบิดเบี้ยวของรูปทรงขึ้น  (Weakness and distortion)  แตในปจจุบัน 2009  
เลนสประเภทน้ีมีการปรับปรุงคุณภาพดีขึ้น  ไมกินแสงและมีคุณภาพของภาพที่ไดดีขึ้น 
 
2. แทนกอปปภาพ (Copy stand) 
 แทนกอปปภาพ (Copying stand)  ประกอบดวยเสาและแปนสําหรับยึดจับกลองถายภาพ ตัวเสายึด
กับแผนกระดานเพื่อใหม่ันคงในการใชงาน ตัวเสามีแปนยึดสําหรับติดกลอง มีอุปกรณมือหมุนใหเล่ือนเขา
ออกและใหเล่ือนสูง – ตํ่า ตามความเหมาะสมในการใชงานไดโดยสะดวก   แทนกอปปบางรุนจะมีไฟสอง
สวางติดมาดวยหรืออาจซ้ือเพ่ิมใหเหมาะสมกับงาน  ควรเลือกใชแทนกอปปใหมีขนาดพอเหมาะกับชนิด
ของกลองและเลนสที่จะใชถาย   ในกรณีของงานถายหนังสือหายากของศูนยวิทยทรัพยากร จุฬาฯ  หนังสือ
หายากสวนใหญมี ขนาด A5  (ประมาณ พ็อคเก็ตบุค)และขนาด A4   งานถายภาพจึงเลือกใชแทนกอปป
ขนาดกลาง พ้ืนของแทนกอปปควรเลือกชนิดสีดําหรือเทา  ควรเปนสีดาน แตไมควรเลือกสีขาว เพราะการ
วัดแสงถายภาพจะหลอกเครื่องวัดแสงใหผิดพลาดได 
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3. ไฟสองสวาง   
ในการเตรียมการเรื่องของแสงนั้น งานถายภาพไดมีการพัฒนาและปรับปรุงเครื่องมือถายภาพและ

ไฟถายภาพ (ตามรายละเอียดปรากฏในหนาตอไป) เพ่ือใหเหมาะสมกับโครงการจัดทําหนังสือ
อิเล็กทรอนิกสครั้งน้ี  ในการผลิตภาพดิจิทัล ภาพสีและสไลดสี อาจมีปญหาเร่ืองคุณภาพงาน อันเปนผล
เน่ืองจากการจดัแสงที่ไมเหมาะสม ไมถูกตอง   แตเดิมภาพสี สไลดสีน้ัน นิยมถายภาพโดยใชฟลมชนิด 
Daylight  การถายภาพสีและสไลดรูปภาพจากหนังสือหรือแคปช่ัน  ตองใชแสงแดดในชวงเวลา 9.30 - 
11.00 น. ถึงจะไดสีดีและถูกตอง ถาถายในชวงบาย ก็มักจะออกอมสีฟา (blue) มากจนเกินไป นอกจากนั้น
ในวันที่แดดไมดี, วันฝนตก ก็ไมสามารถถายสไลดได แตเม่ือมาเปนภาพจากดิจิทัลและการถายที่ใชกลองดิ
จิทัล  ชางภาพตองใชการปรับ WB  (White Balane) และ ก็ตองเลือก light source  ใหถูกตอง 
  
ความเขาใจในเรื่องของทฤษฎีของแสงและสี 
3.1) อุณหภูมิสีของตนกําเนิดแสงไฟประดิษฐ (Artificial   Light) 
 หลอดไฟประดิษฐมีหลากหลายชนิด  หลายประเภท  แตละแบบก็จะใหแสงสวาง   สีและ มี
อุณหภูมิสีแตกตางกันตามชนิดของการผลิตเพ่ือนําไปใชงาน  โดยรวมๆแลว อาจแสดงตารางเปรียบเทียบได
ดังน้ี 
 
ชนิดของตนกําเนิดแสง อุณหภูมิสีโดยประมาณ K 
เปลวเทียน 
หลอดไฟทังสเตนที่ใชในบาน 100วัตต 
หลอดไฟทังสเตนที่ใชถายภาพในสตูดิโอ500 วัตต 
หลอดไฟทังสเตนที่ใชถายภาพ  500 วัตต 
หลอดแฟลชที่ไสหลอดเปนอลูมิเนียม 
หลอดแฟลชที่ไสหลอดเปนเซอรโคเนียม 
หลอดแฟลชสีนํ้าเงิน 
หลอดไฟซีนอน 
หลอดแฟลชอิเล็กทรอนิกส 

2600° 
2800° 
3200° 
3400° 
3800° 
3950° 
5500° 
5400° 
5000°- 6000° 

 
3.2) หลอดไฟฟลูออเรสเซนต  (Fluoresent  lamps)   
 หลอดไฟชนิดน้ีเปนหลอดที่ใหแสงสวางมากกวาหลอดแบบเผาไส ( Incandesent  lamps)  
ส้ินเปลืองพลังงานนอยกวา  ไมรอน  และอายุการใชงานยาวนานกวา  หลอดไฟฟลูออเรสเซนตบางประเภท  
จะสรางมาใหมีสีแสงถูกตองที่สุด  โดยมีคุณลักษณะของหลอดกํากับมา ดังตัวอยางตารางแสดงคา
เปรียบเทียบชนิดของหลอดไฟวาวแสงแตละประเภททีใ่หคาอุณหภูมิสีเทียบเคียงแตกตางกันออกไป 
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ชนิดของหลอดไฟวาวแสง อุณหภูมิสีโดยประมาณ K 
ชนิดแสงขาวขุน (Warm   White  Tube) 
ชนิดแสงกลางวัน (Daylight  tube) 
ชนิดโครมา 50 (Chroma  50 ของ GE) 
ชนิดแสงกลางวัน 5000° (Daylight 5000°) 
ชนิดแสงกลางวัน 5400° (Cool  Daylight  5400°) 
(ของบริษัท  ฟลิปส) 
 

3700° 
4800° 
5000° 
5000° 
5400° 

     
หลอดไฟฟลูออเรสเซนตหรือหลอดไฟวาวแสง  เปนหลอดไฟประดิษฐที่นาสนใจ  นํามาใชในการถายภาพ  
เพราะ ไมรอน ราคาไมแพง  มีคุณลักษณะที่นาสนใจดังน้ี 
หลอดวาวแสง  ตามทฤษฎแีลวตองถือวาไมมีคาอุณหภูมิสีท่ีแทจริง  เพราะการเกิดแสงในหลอดไฟวาวแสง
น้ัน เกิดจากรังสีอุลตราไวโอเลตในหลอด ตกกระทบสารเรืองแสงที่ฉาบไวภายในดานขางหลอด ซ่ึงตางจาก
หลอดจุดไสธรรมดาที่ทําใหหลอดรอน แลวไสหลอดเปลงความสวางออกไป ดังน้ันจึงถือวาหลอดไฟวาว
แสงนี้มีสีของแสงจริง  แตมิไดแสดงระดับของอุณหภูมิ  ความสวางของแสงสวางจากหลอดไฟวาวแสงก็ให
แสงสวาง   เรียกอุณหภูมิสีของหลอดไฟวาวแสงที่คาอุณหภูมิสีเทียบเคียง (correlated colour  tempereture) 
 
3.3)  อุณหภูมิสีของตนกําเนิดแสงธรรมชาติ 
 ในการถายภาพสีดวยฟลม เราตองคาํนึงถึงอุณหภูมิสีของตนกําเนิดแสง  ฟลมที่นํามาถายสไลด 
เชน  ฟลมรีเวอรแซล (Positive   Film) หรือชนิดใชแสงกลางวัน  (Daylight  Type)  ฟลมเหลาน้ีเหมาะกับ
แสงแดดกลางวัน ซ่ึงมีอุณหภูมิสี 5,000° K  ฟลมจะใหสีสมจริงเหมือนธรรมชาติ  ซ่ึงถาอุณหภูมิสีของแสง
เปลี่ยนไปตามธรรมชาติเน่ืองจากทองฟามเีมฆมาก  ชวงเวลาเชา – บาย  ก็จะใหผลของสีแตกตางกันออกไป 
ในเวลากลางวนั   แสงจากดวงอาทิตยจะเปนแหลงแสงธรรมชาติที่สําคัญที่สุด  แตควบคุมไดยากที่สุด  
เพราะจะแปรเปลี่ยนตามวันเวลา  ตําแหนงของดวงอาทิตยในรอบวัน   อุณหภูมิสีดังกลาวน้ีอาจจะแสดงได
ตามตารางขางลางดังน้ี 
ตนกําเนิดแสงธรรมชาติ อุณหภูมิสีโดยประมาณ K 
แสงอาทิตยตอนรุงอรุณ 2000° 
แสงอาทิตยตอน 17.00 น. 4300° 
แสงอาทิตยตอนเที่ยงวัน 5400° 
แสงจันทรคืนวันเพ็ญ 5400° 
แสงกลางวันที่ใชถายภาพสี 5500° 
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แสงกลางวันเฉลี่ยของซีไออี * ชนิดซี 6500° 
แสงกลางวันที่มีเมฆปกคลุมทองฟา 7500°- 8000° 
แสงกลางวันที่ทองฟามีมีฟาเขม 10000°-20000° 

 
3.4) ทฤษฎีของแสงและส ี  

 3.4.1 Correlated color Temperature, CCT.อุณหภูมิของสี (สีของแสง) 
 อุณหภูมิท่ีสัมพันธกันของแหลงกําเนิดแสง แสดงเปนองศาเคลวิน (สัญลักษณ K)  และใชเปน
คําอธิบายแหลงกําเนิดแสงที่มีอุณหภูมิสีสัมพันธที่มีคาต่ํา (2700° K ถึง 3500° K) จัดอยูในกลุมสีอุน เชน สี 
Warm white, White Deluxe และ  Royal white (แสงโคมไฟสวนใหญ มีอุณหภูมิสีระหวาง 2700° K ถึง 
3500° K) แหลงกําเนิดแสงที่เปนฟลูออเรสเซนต มีอุณหภูมิสัมพันธสูงขึ้นมา จัดอยูในกลุมสีเย็น เชน Cool 
white, Cool white Deluxe หรือ แสงกลางวนั อุณหภูมิสีสัมพันธของแหลงกําเนิดสีน้ี มีสวนชวยอยางมากตอ
การปรากฏชัดแจงของพื้นที่ท่ีสวางอยูน้ันทั้งหมด 
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 3.4.2. Color Rendering Index ดัชนีสี CRI 
  ดัชนีสี เปนระบบตัวเลขสากลจาก 0-100 ซ่ึงจะแสดงคุณสมบัติการสะทอนของสีที่สัมพันธ
กันของแหลงกําเนิดแสง เมื่อเปรียบเทียบกับแหลงอางอิงมาตรฐานของคาแสงแบบเดียวกัน ดัชนีจะแสดงคา
องศาซึ่งสีจะปรากฎแบบ “คุนเคย” หรือ “เปนธรรมชาติ”  ภายใตแหลงกําเนิดแสงที่ถูกเลือกมา โดยปกติ
หากคา CRI ยังสูง   สีของวัตถุภายใตแหลงกําเนิดแสงนั้นจะดีขึ้นตามลําดับ คาดัชนี CRI ของแหลงกําเนิด
แสง 2 จุด ควรนํามาเปรียบกันเฉพาะเมื่อท้ังสองแหลงมีอุณหภูมิสีสัมพันธตัวเดียวกันเทาน้ัน 
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การแกไขปญหาและพัฒนางานถายภาพ : ไฟถายภาพ 
ปญหา : ไฟถายภาพที่มีอยูยังไมเหมาะกบัการถายภาพหนังสือหายาก เน่ืองจากหนังสือหายากมีสีตางจาก
หนังสือทั่วไป(จากความเกา)  
 งานถายภาพไดปรับปรุงไฟถายภาพ พรอมแทนถายภาพ copy stand โดยใชหลักการดังน้ี คือ 
การใชไฟ Daylight น้ันตองใชกับฟลม Day light  สีจึงจะออกมาถูกตอง โดยเฉพาะไฟน้ําเงิน Blue Daylight  
หลอดไฟฟาชนิดหลอดไส เปน“หลอดไฟฟาชนิดเปลงแสงจากวัตถุรอน” ภายในหลอด ไฟฟาไหลผานไส
เปนขดลวดบางๆที่มีความตานทานสูง  ลักษณะของไสหลอดจะขดเหมือนสปริง มีขนาดแตกตางกัน ข้ึนอยู
กับกําลังไฟฟาของหลอดไฟฟา  หลอดที่มีกําลังไฟฟาต่ําไสหลอดจะใหญ ความตานทานนอย สวนหลอดท่ี
มีกําลังไฟฟาสูงไสหลอดจะเล็กและมีความตานทานมาก 
 หลอดไสมีหลักการทํางาน คือ เม่ือกระแสไฟฟาผานไสหลอดที่ทําจากทังสเตน ซ่ึงเปนโลหะที่มีจุด
หลอมเหลวสูง จะทาํใหไสรอน เม่ืออุณหภูมิสูงถึง 500 องศาเซลเซียส ไสหลอดก็จะเริ่มเปลงแสงพรอมท้ัง
ปลอยความรอนออกมา ไสหลอดยิ่งรอน แสงสวางก็ย่ิงเพิ่มขึ้นตามไปดวยเม่ือเทียบกับหลอดชนิดอื่น แตก็มี
ความสิ้นเปลืองเพราะเปนหลอดประสิทธิภาพตํ่า พลังงานหมดไปกับการแผรังสีความรอน รังสีอินฟราเรด 
มีเพียง 6 เปอรเซ็นตที่ใหแสงสวาง มีอายุการใชงานสั้น 1,000 ช่ัวโมง  จากนั้นการใหแสงสวางก็จะลดลง  
การทํางานใชการติดต้ังหลอดโดยใชแทนกอปปใหไฟสองเขา 45° ท้ังสองขาง คือ ขางซายและขางขวา  ก็จะ
ไดแสงสวางสําหรับการทาํงานถายภาพ  ชิ้นงานตางๆ สามารถถายสไลด ภาพดิจิทัล ภาพสีที่มีสีสันสวยงาม 
ถูกตอง  แตมีขอเสีย คือ รอนมากๆ และหลอดไฟ Daylight น้ีมีราคาแพง  จัดเปนวัสดุส้ินเปลือง และหาก
ตองถายสไลดจํานวนมาก จะไมสะดวก อยางไรก็ตามวธีิน้ีก็ไมตองคอยแสงแดด 
   
การทดลอง  

หลอดฟลูออเรสเซนต (fluorescent) /หลอดเรืองแสงหรือหลอดวาวแสง “ไสหลอด” ทําดวยโลหะ
ทังสเตนอยูที่ขั้ว  ภายในหลอดฟลูออเรสเซนตสูบอากาศออกจนหมดแลวใสไอปรอทไว  ดานในฉาบดวย
สารวาวแสง ( fluorescent coating ) ซ่ึงจะใหสีตางกัน หลอดฟลูออเรสเซนตเปนหลอดที่มีหลักการใหแสง
สวาง โดยไมเก่ียวของกับการทําใหเกิดความรอน แตใชการถายเทประจุไฟฟา เม่ือจายกระแสไฟฟาเขาไปยัง
ขั้วหลอดทั้งสองขางดวยความตางศักยที่สูง  จะทาํใหขั้วทังเสตนปลอยอิเล็กตรอนออกมาพรอมกันท่ีปลาย
ทั้งสอง ทําใหมีการไหลของกระแส เกิดการอารคระหวางปลายขั้วทั้งสอง  ความรอนจากการอารคจะทาํให
ปรอทเปนไอ การเคลื่อนตัวของอิเล็กตรอนในไอปรอทมีการปลอยรังสีอัลตราไวโอเลต ทําใหสาร
ฟอสเฟอรที่เคลือบดานในหลอดแกวเรืองแสง  หลอดใหแสงสวางสม่ําเสมอ 
 
 การดําเนินการทดลองในการนี้  งานถายภาพไดทดลองนําหลอดฟลูออเรสเซนต GTE Sylvania 
รุน Design 50 มีคา CCT  5000° K, คา CRI = 91 ซ่ึงคาสีของแสงที่ไดจะเปน Daylight เทากับแสงสะทอน
ของแดดภายนอก แตของงานถายภาพจะคงที่  ท่ี 5000° K และมีคา CRI 91 ซ่ึงคาขนาดนี้ จะใหสีถูกตองตาม
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ความจริง จึงนําหลอดนี้มาใชโดยตรงในการถายภาพ โดยทําเปนโคมไฟใสหลอด ขางละ 4 หลอด ทั้ง
ดานซายและขวา ทาํใหไดแทนกอบปพรอมโคมไฟ (ดูรูป) เปนชุดสําเร็จพรอมใช  ทําใหสามารถใหบริการ
ถายภาพในหองปฏิบัติการถายภาพของงานถายภาพไดตลอดเวลา 
 
 

 
 
 
  ตัวแปรการทดสอบ  ไดทดสอบโดยใชฟลมสไลดสี และฟลมสี และถายภาพดิจิทัล ถายไฟ 
Day light ถายแสงแดดเวลา 10.00 น. ในวันที่มีอากาศแจมใส และถายไฟถายภาพ Design 50 โดยถายแผน
ทดสอบสี The  macbeth color checker (color Rendition Chart) 
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  ผลการทดสอบ  ภาพที่ไดจากฟลมสไลดสี และฟลมสี และภาพถายดิจิทัล คุณลักษณะของสี
ไมแตกตางกัน จากไดทดลองปฏิบัติ  ปรากฎวาผลเปนที่ยอมรับและพึงพอใจ สําหรับเจาของงาน 
 
ผลตอเน่ืองจากการทดลอง 

ปจจุบัน งานถายภาพไดพัฒนาและปรับปรุงไฟถายภาพเพิ่มเติม โดยนําหลอดคอมแพคฟลูออเรส
เซนต (หลอดตะเกียบ) ชนิดที่มีบัลลาสตอยูภายในใชแทนหลอดฟลูออเรสเซนตทรงกระบอกยาว ทําใหมุม
ของการใหแสง/ หลบแสงสะทอนดีขึ้น  โดยคุณสมบัติที่สําคัญของหลอดตะเกียบชนิดน้ี คือ ชวยประหยัด
พลังงานไฟฟาและมีอายุการใชงานที่ยาวนานกวาหลอดฟลูออเรสเซนต โคมไฟสองลงในพ้ืนที่ ใหแสงทั่ว
ในบริเวณที่จําเปนตองเปดไฟไวนาน  
 
แสงและลักษณะของตําแหนงดวงไฟ 
 แทนกอปปที่ติดกลองแลวน้ัน เม่ือวางหนังสือก็พรอมจะถายไปไดทีละหนา โดยอาจอาศัยแสงจาก
ธรรมชาติ คือแสงแดด โดยใหแสงเขาทางดานหนา ไมมีอะไรมาบังเวลาถาย  สังเกตสภาพแสงที่ตกกระทบ
บนหนากระดาษวา เรียบเสมอกันก็ใชได  แตถาไมมีแสงแดด ก็ถายไมได  หากมีแสง แตสภาพแสงไมดีก็
ถายไมได นอกจากนั้นระดับความเขมของแสงที่เปล่ียนไป จะทําใหสีของภาพ คือสีของหนากระดาษ
แตกตางกันไปอีกดวย  ในการทํางานโครงการจัดทําหนังสืออิเล็กทรอนิกสครั้งน้ี งานถายภาพไดทดสอบ
ออกแบบไฟโดยใชไฟประดิษฐ มาเปนแหลงกําเนิดแสง  เพ่ือใหไดสภาพแสงที่สม่ําเสมอ อํานวยความ
สะดวกในการปฏิบัติงานไดเปนอยางดี  
 การถายทําควรวางแทนกอปปภาพบนโตะสูงขนาดพอเหมาะกับตัวบุคคลผูปฏิบัติงาน จัดตําแหนง
ดวงไฟใหสองสวางลงที่บริเวณหนังสือบนกระดานของแทนกอปป  ใหแสงสวางน้ันเกลี่ยท่ัวหนาหนังสือ
ใหแสงเขาทางดานขาง คือดานซาย และขวาทาํมุม 60  
 ตําแหนงของแสงมีผลตอคุณภาพของภาพมาก  ในกรณีมุมหลอดไฟสองแสงทํามุม 60  กับ
แกนกลางของกลองน้ัน  จะทําใหแสงมีมมุที่หางจากเลนสของกลอง  ทําใหลดการสะทอนแสงของภาพไป
ยังเลนสนอยลง ทําใหลดการแฟลรลง  นอกจากนั้นการใชเลนสฮูดสวมไวหนาเลนสแมคโคร  ก็ชวยปองกัน
ไดระดับหน่ึงเชนกัน  เม่ือสภาพแสงที่ใชในการถายภาพมีคุณภาพดี มุมในถายภาพทําใหการสองสวาง
ถูกตอง แสงสวางเกล่ียบนผิวกระดาษดี  ผลลัพธ คือ  ความเปรียบตางของสีขาวและดํา(Contrast) ดีขึ้นและ
ทําใหภาพมีความอิ่มตัวของสี คือ Saturation สมบูรณดี 
 อยางไรก็ดี การวางตาํแหนงไฟนั้นข้ึนอยูกับลักษณะของไฟ  ไฟสมัยใหมเปนแบบหลอดตะเกียบ 
ไฟเปนแผงสี่เหลี่ยมมีแผนกระจายแสง  ลดการ Hot spot ลงที่แสงบนวัตถุได    อน่ึงการจัดไฟท่ีตําแหนง   
45 - 60  จากแกนกลางก็เปนมุมที่ใชได     ในการถายกอปปภาพ ตองหมั่นสังเกตและคอย ๆ  ถายทํา เก็บ
รายละเอียดผลงานและทดสอบตัวแปรตางๆ จนกวาจะไดเปนที่พึงพอใจ 
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4. สายลั่นไกชัตเตอร 
การใชสายลั่นชัตเตอรซ่ึงเปนอุปกรณสําหรับกดชัตเตอรน้ัน  เม่ือติดตั้งกลองรวมกันกับขาตั้งแลว 

สายลั่นชัตเตอรจะชวยลดความสั่นสะเทือนในการกดชัตเตอร  ทําใหภาพไมส่ันไหว  และยังใชล็อคชัตเตอร
เมื่อเวลาตองการบันทึกภาพเปนเวลานานๆดวย   สายลั่นไกชัตเตอรราคาไมแพง  ชวยใหกดชัตเตอรได
นุมนวลและไมทําใหกลองส่ันไหว 

 
5. ขาตั้งกลอง 

ขาตั้งกลองเปนอุปกรณสําหรับการตั้งกลองเพื่อใหกลองน่ิงมากกวาการถือกลองดวยมือ  ขาต้ัง
กลองมีความจาํเปนมากเมื่อตองถายภาพนานๆ   ควรเลือกใชขาต้ังสําหรับตั้งกลองชนิดที่แข็งแรง  เน่ืองจาก
บางครั้ง ชางภาพก็ตองถายภาพในที่ๆ มีแสงนอยๆ  การจะใชเลนสขนาดใหญหรือมีนํ้าหนักมากๆ ทําไดไม
สะดวก และหากไมใช ภาพก็จะสั่นไหว  ไมคมชัด  ดังน้ันในที่มีแสงนอยและไมสามารถถือกลองดวยมือ 
หรือเมื่อตองใชความเร็วชัตเตอรต่ําๆ เพ่ือใหแสงพอดี  จึงตองอาศัยขาตั้งกลองชวย  ขาตั้งกลองที่ไมแข็งแรง
ทําใหไดภาพที่ถายพรามัว ไมคมชัดไดเชนกัน  ในกรณีที่ไมแนใจวาขาต้ังจะมั่นคงดีหรือไม    ใหเตรียมใช
ถุงทรายหนักๆ ตางน้ําหนักแขวนถวง เปนการลดความสั่นสะเทือนลง   สวนการใชสายล่ันชัตเตอรซ่ึงเปน
อุปกรณสําหรับกดชัตเตอร  เม่ือติดตั้งกลองรวมกันกับขาตั้งแลว สายลั่นไกชัตเตอรจะชวยลดความ
ส่ันสะเทือนในการกดชัตเตอรไดอีกทางหนึ่งดวย  เพ่ิมความมั่นใจวาภาพจะไมส่ันไหว  

บางครั้งพบวาหนากระดาษมีใบแทรกเปนแผนที่ขนาดใหญ ชางภาพไมอาจถายภาพไดโดยใชแทน
ถายภาพปกติ ชางภาพตองดัดแปลงโดยการนําขาตั้งกลองมาใชยึดกลอง เอกสารที่จะถายตองแผออกขึงให
ตึงจัดมุมกลองและระดับใหภาพอยูในกรอบจึงจะถายทาํได 

 
6 . กระดาษสีดําดาน  
 กระดาษสําหรับรองหนากระดาษเพ่ือถายภาพ ควรเลือกใชกระดาษโปสเตอรสีดําดานสนิท ใหตัด
ไวหลายๆ  ขนาด  โดยใหมีขนาดใหญกวาหนาหนังสือ 
 
7. กระจกดาน (Matte mirror) 
กระจกดาน  เปน กระจกพ้ืนผิวเรียบและไมสะทอนแสง ควรจัดหาไวและตัดไวเพ่ือทับหนากระดาษใหเลือก
ตัดไวหลายๆ  ขนาด  เชน ขนาด 5" x  7"  ขนาด 8"  x 10" และ 10" x 12"  เจียรมุมดวยหินลับมีดหรือกระดาษ
ทรายขัดเหล็ก จากน้ันใชกระดาษกาวแรกซีนหุมขอบกระจก 
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ขั้นตอนการถายภาพ 
 1. ยึดจับกลองกับอุปกรณ  ยึดขันกับสกรู ยึดกลองใหแนน ดูระดับของกลองวาขนานกับพ้ืนแทน
กอปปหรือไม ถายังไมขนาน ตองเปลี่ยนใหไดระนาบขนาน อาจใชทีว่ัดระดับน้ําชวย 
  2. วางหนังสือที่จะถายลงบนพ้ืนแทนถายภาพ 
  3. มองในวิวไฟนเดอรกลอง หรือ จอ LCD ของกลองวาไดระนาบ  ภาพมีอาการบิดเบอืนเอียงซาย
หรือไม 
  4. วัดแสงและลงมือถายทําไดปกติเหมือนการถายภาพทั่วไป  
Photo tip 

Mode Live View โหมดน้ีจะชวยใหในขณะทําการถายภาพ  ชางภาพจะมองในชองมองภาพเพื่อดู
รูปท่ีจะถายหนังสือหายากแตละหนา  เม่ือจัดเรียงหนาตามลําดับที่จะถายแลวน้ัน  กลอง 35 DSLR บางรุน 
ชางภาพสามารถใชจอ LCD ดานหลังและปจจุบัน (2009) นิยมทําจอภาพขนาด LCD ใหญ  ชวยในการ
มองเห็นภาพที่จะถายไดดีขึ้น  ชางภาพสามารถเลือกองคประกอบ  จัดสัดสวนภาพ ดู ความเหมาะสมไดดี
ย่ิงข้ึน  เพราะมองเห็นไดชัดเจนมากกวาในชองมองภาพ  การถายหนังสือหายากน้ี  ตองพิจารณาทัง้ความ
คมชัดและความสวางของหนากระดาษวา มีคุณภาพของสีและการตัดกันของตัวหนังสือและพ้ืนกระดาษวา
เปนอยางไร 

 
การเลือกโหมด Program 
การเลือกโหมด Program ของกลองดิจิทัล DSLR ที่เหมาะสมจะทาํใหการปฎิบัติงานงายข้ึนและ

สะดวกรวดเร็วมาก mode AV หรือโหมด Arerture priority ชางภาพใชเพ่ือเลือกควบคุมความชัดลึกของภาพ
ในโหมดนี้ เม่ือตั้งคารูรับแสงที่ f/22 จะเปนการตั้งระยะความชัดลึกของเลนสถายภาพมากที่สุด กลไกของ
กลองจะเลือกสปดชัตเตอรที่สัมพันธกันให ถึงสปดชัตเตอรจะต่าํก็ไมเปนไร เพราะตัวกลองยึดอยูกับแทน
กอบปอยางแนนหนาแลว ชางภาพจึงอาจใชสปดชัตเตอรต่ําๆ ได โดยไมตองกลัวภาพจะสั่นไหว (แตก็ควร
ใชสายลั่นไกชัตเตอรดวย) 

 
การตั้งคา ISO  
ISO  คือคาความไวแสงชางภาพเลือก การตั้งคา ISO สําหรับสภาพแสงเมื่อสภาพแสงนอย จะเลือก

ต่ํา คา ISO สูงๆเชนที่800,1600 แตถาสภาพแสงมากจะตัง้ ISO ต่าํเชนที่100,200ที่คาISO ตํ่าจะเกิด Noise ใน
ภาพนอย และในทางกลับกันถา ISO ย่ิงสูงมากๆ ก็จะมี Noise เกิดขึ้นมาก 
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ในการจัดทําหนังสือหายาก ชางภาพจัดสภาพแสงใหเหมาะสม คือ มีปริมาณแสงเกลื่ยลงในหนา
หนังสือพอดีแลว จึงเลือกใช ISO ประมาณ 200 เพ่ือหลีกเล่ียง Noise ท่ีจะเกิดขึ้น 

 
 
 

การวัดแสง  (Metering) 
 กลอง  DSLR สมัยปจจุบันมีการวัดแสงที่แมนยําและเที่ยงตรงมากในการวัดแสงนั้น จะมีรูปแบบ
การวัดแสงที่แตกตางกันออกไป แตผลลัพธก็คือ ชางภาพตองการวัดแสงใหพอดี ถาวัดแสงผิดพลาดผลที่
เกิดข้ึนคือ ภาพที่บางไป ภาพออกมาสวางมาก เรียกวา ภาพโอเวอร  (OVER)  ในทางตรงกันขามถาวัดแสง
แลวภาพที่ออกมาดํามืดเกินไป เรียกวา ภาพอันเดอร (UNDER)  ภาพใน 2 ลักษณะนี้เปนภาพที่ขาด
รายละเอียดและไมมีคุณภาพ หมายรวมถึงวา การถายภาพน้ันไมมีคุณภาพดวย 
 ชางภาพตองพยายามวัดแสงใหภาพที่ถายไดออกมาพอดี ตรงน้ีตองใชทักษะและความสังเกต จดจํา
อยูบอยครั้ง แตกฎพ้ืนฐานอยางแรกคือ ตองเขาใจระบบการวัดแสงของกลองกอน 
 
การวัดแสงของกลองน้ัน มี 3 แบบ หลักๆ คือ 
 1. การวัดแสงแบบเฉพาะจุด (Spot Metering)  กลองจะวัดแสงเฉพาะจุดเทาน้ัน  แบบวิธีวัดแสง
แบบนี้ จะใชเฉพาะภาพวัตถุที่ตองการเนน ตรงจุดน้ันๆ ก็จะพอดี ซ่ึงโดยปกติ การวัดแสงเฉพาะจุด จะวัด
ประมาณ 3-4% ของพ้ืนที่ ทําใหตรงจุดพอดี แตบริเวณฐานรอบนอกจุดน้ันๆ ก็จะมืด หรือ สวาง แลวแต
สภาพแสงและบรรยากาศ 
 2. การวัดแสงแบบเฉลี่ยหนักกลาง(Center weighted Metering)  การวัดแสงแบบนี้เหมาะสําหรับ
การถายภาพกรณี วัตถุในภาพอยูตรงกลาง (มีมวลนํ้าหนักภาพเนนตรงกลาง)  ของภาพ กลองจะวัดแสง
เฉพาะวัตถุในภาพอยูตรงกลาง และวัดแสง รอบนอกดวยเล็กนอยทําใหภาพที่ถายไดมีสภาพแสงพอดี เพราะ
การวัดแสงแบบเนนเฉพาะวัตถุอยูตรงกลาง 
 3. การวัดแสงแบบเฉลี่ยทั้งภาพ (Average Metering ) การวัดแสงแบบนี้ กลองจะทําการวัดแสง
เทากันทุกพ้ืนที่ในภาพ แลวกลองจะนํามามวนในหาคาเฉลี่ยใหกับภาพท้ังหมด วิธีการวัดแบบน้ีดีตรงมัน
สะทอนความเปนจริง เชน ถาพ้ืนที่สวนใหญมืด ภาพที่ไดก็จะออกมามืด แตถาภาพสวนใหญเห็นภาพสวาง 
ภาพที่ไดก็จะออกมาสวาง ทั้งที่ในความเปนจริงชางภาพ ตองการใหภาพออกมาพอดี  
 ในการปฏิบัติงานถายภาพ หนังสือหายาก การเลือกระบบวัดแสงของกลองใหเลือกระบบวัดแสง
แบบเฉลี่ยทั้งภาพ เพราะวาเปนการวัดหนากระดาษทั้งหนา และหนากระดาษมีสีขาวหมนจนถึงสีนํ้าตาล ตัด
กับหมึกจากการพิมพตัวตะกึ่งสีดํา จากนั้นใหทดลอง สังเกตผลลัพธที่ได จากนั้นใหชดเชยแสงของกลอง
โดยใช โหมด conpensate( 1+........0........- )1ทดลองถายทําดูสังเกตและจดบันทึก ทดลองจนไดคาที่พอดี 
สําหรับ การถายภาพหนากระดาษ 
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เทคนิคเพ่ือความคมชัดของการถายภาพหนังสือหายาก 

ในการถายภาพหนังสือหายากนั้น ชางภาพจะพลิกหนากระดาษไปทีละหนา มองในวิวไฟนเดอร
ของกลองและดูภาพหนาหนังสือท่ีปรากฏในจอภาพวา หนาเอียงซายขวา ตองหนุนรองดวยวัสดุใดใหได
ระดับ ถึงจะถายได  หลักสําคัญคือ ทําใหหนาแผนกระดาษนั้นเรียบท่ีสดุ จึงจะลงมือถายทําหนาน้ันได 
บางครั้งตองใชวิธีการกดอยางระมัดระวัง หรือใชวัสดุมีนํ้าหนักทับ เม่ือแกไขปญหาความเรียบไดแลว ก็
พรอมถายได  การใชกระจกทับหนากระดาษขณะถายภาพ ก็เปนอีกวิธีหน่ึงที่ชวยใหหนากระดาษเรียบ     
ไมโกงหรือโคงงอ   กระจกน้ันเลือกใชกระจกที่เรียกกันวา  กระจกดาน (Matte mirror) เพราะเปนกระจกที่
นอกจากเปนพ้ืนผิวเรียบแลวยังไมสะทอนแสง ไมกอใหเกิดจุด hot spot บนพ้ืนผิวกระจก  แตบางครั้งเนื้อ
กระดาษการพิมพหนาหนังสือน้ันมีปญหา เชน ใชหมึกดําและกระดาษหนังสือบาง ทําใหหมึกซึมขึ้นมาเปน
เงาสีเทาดําลางๆ ใหแกปญหาดวยการนํากระดาษสีดํามารองดานใต จะชวยแกปญหานี้ได 
 ในสวนที่เปนเลนสถายภาพนั้น หากชางภาพเลือกใชเลนสแมคโคร ควรเลือกเปดกลอง คือรูรับแสง
ใหเหมาะสม ไมควรเลือกเปดรูรับแสงคาเลขเอฟสูงๆ เชน 22 เพ่ือเนนความคมชัดลึกเกินไป เพราะ ที่คาเอฟ
ขนาดน้ี ชองเปดรูรับแสงของเลนสนั้นมีขนาดเล็กเกินไป จะทําใหเกิดการเลี้ยวเบนของแสง  แสงที่เล้ียวเบน
น้ีจะทําใหคุณภาพของภาพที่ไดต่ํา มีผลทําใหคุณภาพของภาพที่ไดไมคมชัด 

 
 
 

ขั้นตอนการปรับแตงภาพใหสวยงามกอนนําสง 
ในกระบวนการถายภาพดิจิทัลน้ันเมื่อถายภาพแลวชางภาพตองใชโปรแกรมตกแตงภาพ Photoshop  

CS แตงภาพทางเทคนิคเพ่ือใหสวยงามมากกวาที่ถายมาได เชนโดยใชคําสั่งปรับแตงสีและแสงเงา อยูใน 
เมนู Image >ADJUSTMENT เชน  การปรับดวยคําส่ังอัตโนมัติ (Auto  Levels)การปรับความคมชัด  
(Sharpness)   ,การปรับคาความสวางและความมืดของภาพ (over and under  exposure) 
โดยพิจารณาเครื่องมือ/คาการทํางาน ตาง  ลักษณะ  ซ่ึงชางภาพทุกคนตองสามารถปฏิบัติได ดังน้ี  
 
1. คาโทนสี การ ปรับแตงสีและแสงเงา Levels 
เน่ืองจากชวงโทนสีของกลองแคบ ภาพท่ีไดจึงมีสีความเขมนอยกวาฟลมสไลด ชางภาพตองปรับคาโทนสี 
(level) เพ่ือใหไดภาพที่มีความเขมข้ึน หรือภาษาถายภาพคือ “มีเน้ือน่ันเอง”   
การปรับคา Levels  มี 2 วิธีดวยกัน คือ 
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          1) ปรับดวยคําส่ังอัตโนมัติ (Auto  Levels)  
สามารถใหโปรแกรมปรับคาอัตโนมัติได โดยคลิกเมนู  Image > Adjustments > Auto  Levels   
โปรแกรมจะประมวลผลปรับระดับความอิ่มตัวสีใหโดยอัตโนมัติ 
1.เปดไฟลภาพ 
2.เลือกคําส่ัง  Auto  Levels 
3.ภาพจะอ่ิมตัวสีมากข้ึน 
          2.) การปรับแตงดวยคําสั่ง (Manual  Levels)  
ในบางครั้งการปรับแตงภาพอัตโนมัติจากคําสั่ง Auto  Levels  อาจไดภาพไมสวย (เน่ืองจากลักษณะของ
ภาพ)  เราสามารถปรับไดโดยคลิกเมนู  Image > Adjustments>  Levels….  เม่ือปรากฎหนาตาง  Levels  ให
เล่ือนเมาสปุมสามเหลี่ยม  ปรับคาพรอมสังเกตผลลัพธ  (เพ่ิม – ลดคาชอง  Input  Levels)  
คานอยลงจะทําใหภาพเขมและตัดกันมาก  คามากขึ้นทําใหภาพสวางและตัดกันนอย 
1.เปดไฟลภาพ 
2.เลือกคําส่ัง  Levels 
3.ปรับคาสังเกตภาพและที่ตองการ 
4.ภาพจะอ่ิมตัวสีมากข้ึน 
2. การปรับคาความสวางและความมืดของภาพ (over and under  exposure)โดยใชคําสั่งปรับคาความสวาง
และความมืดของภาพ อยูใน เมนู IMAGE >ADJUSTMENT>CURVES 
วิธีการปรับภาพถายที่มืดใหสวางขึ้น  (Under  exposure) 

 ภาพมืด ที่เรียกวาภาพ “Under exposure”  น้ัน มีวิธีการแกไข คือ เพ่ิมความสวางใหกับภาพ   
ปจจุบันไฟลภาพดิจิทัลที่ถายมา Under สามารถแกไขได โดยแกไขความสวางเฉพาะสวนที่มืดในภาพดวย
คําสั่งในโปรแกรม Photoshop  วิธีการเพิ่มความสวางภาพดวยคําสั่ง  Curves  ทําไดดังน้ี 

 1. สราง  Selection จุดที่ตองเพิ่มความสวาง 
 2. ใชคําส่ัง  Curves…เลือกคําสั่งปรับสีแบบเสนโคง  ใหคลิกบนเสน   
 3. ลากเมาสเพ่ิมความสวางใหกับทั้งภาพ  Channel : RGB    
 

วิธีการการปรบัภาพถายที่สวางเกินไปใหเขนขึ้น  (Over  exposure) 
 ภาพที่มีความสวางมากเกิน  เรียกวา “Over  exposure”  วธีิแกไขโดยปกติคือ ลดแสงใหนอยลง
กวาเดิม ไฟลภาพดิจิทัลสามารถแกไขใน  Photoshop  ดวยขั้นตอนดังน้ี 
  1. คลิกปุมเมาส เลือกคําส่ัง Curves… 
  2. คลิกบนเสนและเลื่อนลงเพ่ือใหระดับสีอิ่มข้ึน 
  3. สังเกตภาพผลลัพธที่ได 
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3. คาการปรับความคมชัด (Sharpness)  โดยใชคําสั่งปรับปรับความคมชัด อยูใน เมนู FILTERr>SHARPEN 
 
แมวาคุณภาพของ CCD  และ CMOS จะดีเพียงใด ก็ยังไมสามารถใหคุณภาพของไฟลภาพคมชัดเทาฟลมได   
การใช Mode  Sharpening  ใน Photoshop  CS  จะทาํใหไฟลภาพดิจิทัลมีความคมชัดมากขึ้น ซ่ึงสามารถทาํ
ไดดังน้ี 

1)  ใสฟลเตอรใหภาพชัด 
Copy  เลเยอรเพ่ิมขึ้น 1  เลเยอร ใสฟลเตอร  Unsharp  Mask  ผลทําใหภาพชัดขึ้น สามารถกําหนดคาความ
คมชัดใหเพ่ิมข้ึนตามตองการ  ดูผลลัพธจากชอง Preview  ของฟลเตอร 

1. Copy  เลเยอร 
2. ใสฟลเตอร  Unsharp  Mask… 
3. ปรับคาใหภาพชัดขึ้น 

  Amoun t  : 500 (เพ่ิมความชัด) 
  Radius      : 3.0 (คารัศมีการเพ่ิมความชัด) 
  Threshold : 5   (เกลี่ยระดับความคมชัด 5 ระดับ) 
2)  เปลี่ยนโหมดใหภาพเปนธรรมชาติ 

การใสฟลเตอรเพ่ิมความคมชัดมากขึ้น  ทําใหภาพเกิด Grain หรือจุด  pixels  ภาพจะดูแตก ไมเปนธรรมชาติ
ตองเปลี่ยน  Blending  Mode   ใหภาพเกล่ียจุดเหลาน้ีอยางนุมนวล  หลังจากแกไขเสร็จก็สามารถรวมเลเยอร
เปนภาพปกติ 

 1. เลือกโหมด  Luminosity 
 2. คลิกเมนู  Layer > Flatten  Image 
 

โดยใชคําสั่งการตัดสวนภาพ อยูใน เมนู Image> Canvas  Size   
 
4. คาการตัดสวนภาพ (Cropping)  โดยใชคําส่ังการตัดสวนภาพ อยูใน เมน ูImage> Canvas  Size   
การตัดสวนภาพในโปรแกรมตกแตงภาพ  Photoshop  CS  ก็เหมือนกับการตัดสวนภาพ (Cropping)ในหอง
มืดเวลาอัดขยายรูปขาวดําหรือรูปสีน่ันเอง  ภาพที่ไดจากการตัดสวน (cropping) จะมอีงคประกอบของภาพ
ที่สมบูรณขึ้น สีและสัดสวนของจุดสนใจในภาพดีข้ึน 
วิธีการครอปภาพเพื่อยอ – ขยายภาพ สามารถทําไดดังน้ี 
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การปรับขนาดภาพใหเปลี่ยนไปสามารถทําไดโดยชุดโปรแกรมสําเร็จรปู ดวยคําสั่ง  Canvas  Size  
( Image > Canvas  Size…)  โปรแกรมจะ  Crop  เหลือบริเวณสวนที่ตองการในภาพ  หรือขยายภาพเพิ่มขึ้น
จากเดิม ตามขั้นตอนดานลาง 

 1.ภาพถาย 
 2.ขนาดเบื้องตน 
 3.กรอกคาลดลง 
 4.เลือกทิศทางการ  Crop 
 5.ปุม Proceed 
 6.ภาพถูก Crop เล็กลง 
 

วิธีการครอปภาพเพื่อเลือกเฉพาะสวนที่ตองการ สามารถทําไดดังน้ี 
การใชโปรแกรมสําเร็จรูป crop ภาพเฉพาะสวนที่ตองการนั้นมักจะใชในกรณีที่ไมสามารถ

กําหนดคาดวยคําสั่ง  Canvas  Size   ไดอยางสะดวก  โดยใชวิธีการดังน้ี  
 1.ลากเมาสเลือกเลือกบริเวณ  Crop   
 2.หมุนกรอบใหพอดีเพ่ือเลือกเฉพาะบริเวณที่ตองการ 
 3.กดปุม < Enter>  
 4.ภาพถูก Crop ใหเล็ก 
 

  
    เม่ือปรับแตงภาพดิจิทัลเรียบรอยแลว ชางภาพตองเก็บไฟลภาพน้ันลง CD/DVD ตามที่กําหนด 
ภาพดิจิทัลแตละแผน แตละซอง/กลองท่ีใสหรือกลองกํากับ ตองลงรายละเอียดของหนังสือใหชัดเจน เชน 
ชื่อหนังสือ ลงวัน เดือน ป จากนั้น จัดกลุม CD/DVD ทั้งหมด  เพ่ือนํามาเขาระบบการจัดเก็บโดยมีการแบง
หมวดหมูใหชัดเจน เพ่ือสะดวกตอการคนคืนเมื่อตองการ   
 
 
ขั้นตอนการนําสงไฟลภาพและตนฉบับคืน 
เมื่อชางภาพเตรียมงานภาพ ตกแตงภาพ และนําใสกลอง/ซอง พรอมระบุรายละเอียดตามกาํหนดแลว จะนํา
ไฟลภาพพรอมตนฉบับหนังสือสงคืนบรรณารักษเจาของงาน ซึ่งเมื่อบรรณารักษรับงานพรอมตรวจสอบ
ความถูกตองครบถวนของขอมูล รวมทั้งตรวจหนังสือตนฉบับวาไมมีความเสียหายแลว บรรณารักษจะเปน
ผูนําขึ้นสูกระบวนการจัดแสดงบนเวบไซต หนา e- Text ตอไป 
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อภิปรายผลโครงการและขอเสนอแนะ 
 

องคความรูท่ีไดจากการจัดทําหนังสืออิเล็กทรอนิกสฯ (Lessons learned) 
 ความพยายามในการแปลงสื่อสารนิเทศเปนสื่อดิจิทัลไดรับการพัฒนามากขึ้นในงานสื่อโสตทัศน
หลายประเภท แตการเริ่มทดลองดําเนินการกับสื่อส่ิงพิมพน้ัน  ศูนยวิทยทรัพยากรไดตัดสินใจเริ่มโครงการ
กับงานหนังสือหายากกอน เพราะนอกจากจะเปนการแปลงสื่อเพ่ืองานบริการแลว ยังไดประโยชนในแงงาน
อนุรักษดวย  เม่ือเริ่มดําเนินงานกับหนังสือหายากไดมีการคิดหาวิธีการหลากหลายเพื่อการทํางานทีม่ี
ประสิทธิภาพประสิทธิผลสูงสุด  เริ่มที่การเลือกวิธีการแปลงหนาหนังสือ  ชวงแรกคิดวาจะเลือกใช
โปรแกรม OCR  (Optical Characters Recognition)แตพบวา เกิดปญหาเทคนิคดานฟอนตอักษร เน่ืองจาก
ตัวอักษรของหนังสือหายากเปนตัวพิมพตะกั่วยุคโบราณ โปรแกรมปจจุบันไมสามารถเลือกหาฟอนตอักษร
อานได   ทางเลือกตอมาคือ การใชโปรแกรมสแกนหนาหนังสือ   ในกรณีของหนังสือใหมถือเปนวิธีที่ดีและ
รวดเร็ว แตหากเปนหนังสือหายากที่เปนหนังสือเกา หนากระดาษบางและกรอบ การสแกนหนาหนังสือ
เทากับเปนการทําลายหนังสือโดยตรง  ทางเลือกที่ดีที่สุดขณะนั้นจึงไดแก การใชกลองดิจิทัลถายภาพทีละ
หนาโดยใชชางภาพผูชํานาญ การนํามาเรียงรอยเปนเลมตามรูปแบบทางกายภาพ 
  

งานถายภาพจงึไดรับมอบหมายใหดําเนินการโครงการทดลองนี้ ( pilot project)  (ตามที่ไดกลาวมา
ในตอนตน)  เมื่อส้ินสุดการทําโครงการฯ งานถายภาพใหไดรับขอความรูอันอาจประมวลเปนองคความรู
เพ่ือประโยชนในการปฏิบัติงานและการจัดทําหนังสืออิเล็กทรอนิกสในอนาคตได ดังน้ี 

 
1. เพ่ิมพูนความรูและทักษะของผูปฏิบัติงานในการถายภาพลักษณะพิเศษ ตัวอยางความรูที่ไดจาก

การศึกษาเทคนิคของเครื่องมือและวิธีการในการถายภาพหนังสือหายากครั้งน้ี ไดแก 
1) ความรูเรื่องการจัดแสงสําหรับหนังสือหายากที่มีสีตางจากหนังสือปกติ (ปรากฏ

รายละเอียดใน การทดลองเรื่องการจัดไฟ) 
2) ชางภาพตองมีและ/หรือเพ่ิมพูนความรูเก่ียวกับการถายภาพและเครื่องมือและอุปกรณ

ถายภาพที่เก่ียวของเปนพิเศษ เชน เลนสมาโคร และ แทนกอปป  
3) เทคนิคการจับภาพใหใกลๆ หมายถึง การนํากลองและเลนฺสเขาใกลใหไดตัวหนังสือ

เต็มหนาพอดี จะเห็นตัวหนังสือชัดเจน ทําใหตัวหนังสือมีความคมชัดเจนมากขึ้น 
4) สังเกตพื้นหลังวามีหมึกพิมพเลอะขึ้นมาไหม  หากมีตองใชกระดาษดําสอดขางใต 
5) สังเกตลักษณะที่แตกตางในภาพ เชน เม่ือเปดถายทีละหนา ตองสังเกตสิ่งผิดปกติกอน

ถายทุกคร้ัง เชน อาจมีเศษวสัดุแปลกปลอมคั่นอยูในหนากระดาษ ตองนําสิ่งผิดปกติ
น้ันออก หรือพบหนา(พิมพ)ผิด 
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6) วิธีการปฏิบัติงานถายภาพดวยกลองดิจิตอล  เปนวิธีหน่ึงที่ใชไดดีในงานหนังสือหา
ยากอิเล็กทรอนิกส  แตก็ไมใชงานงาย ชางภาพตองไดรับการฝกฝนมากพอสมควรใน
ประเด็นดังน้ี 

• ความรูความเขาใจเรื่องกลองอยางดี  ตองรูจักเลือกเลนส/  เลือกกลอง 
• ชางภาพตองเขาใจวิธีการทํางานถายภาพเพื่อใหไดคุณภาพดี 
• ชางภาพตองเปนนักอนุรักษหนังสือดวย  เชน  ในขณะถายภาพนั้นควรตอง

ใสถุงมือขณะจับตองหนังสือและเมื่อทาํการถายทําไปทีละหนาน้ัน  หากมี
หนากระดาษเสียหายตองเพิ่มความระมัดระวังเปนพิเศษ  ตองเก็บชิ้นสวน 
ใสซองกระดาษ เขียนเลขหมายหนาชํารุดหนาซอง  และใสกลองรวมไวเพ่ือ
ความสมบูรณของตัวเลม เมือ่สงคืนแกบรรณารักษ 

  
2.  สรางความรูความเขาใจในคุณคาของหนังสือหายาก ซ่ึงเปนมรดกทางภูมิปญญาของประเทศ 

1) หนังสือหายากสวนใหญเปนหนังสือท่ีมีอายุมาก ตีพิมพขอความรูในอดีต ซ่ึงเปนการ
สงผานมรดกทางวัฒนธรรม และภูมิปญญาจากอดีตมาสูปจจุบัน  การถายทอดจากสื่อ
ส่ิงพิมพซ่ึงไมอาจเขาถึงไดงาย มาเปนสื่อดิจิตอล ซ่ึงสามารถเขาถึงและเผยแพรสู
สาธารณะไดงาย นอกจากจะทําใหสารสนเทศนั้นคงอยูอยางดีแลว ยังสามารถนําเสนอ
สูคนรุนใหมผานเทคโนโลยีที่ทันสมัยไดดวย 

2) เม่ือหนังสือหายากอิเล็กทรอนิกสไดรับการเผยแพรสูสาธารณะอยางกวางขวางแลวน้ัน 
เปนที่เช่ือไดวา หนังสือหายากอีกจํานวนมากที่ยังไมไดรับความสนใจ หรือยังไมเปนที่
รูจัก จะมีการสนใจคนควาศึกษามากขึ้น  

 
3. เกิดความเชื่อมโยงระหวางนวัตกรรมใหมๆ ทางดานเทคโนโลยีสารสนเทศและเทคโนโลยี

ทางการศึกษากับงานหองสมุด 
1) งานหองสมุดแบบดั้งเดิมเนนการรวบรวมสารสนเทศประเภทตางๆ ไวในที่เดียวกัน 

เพ่ือความสะดวกในการคนควาของผูใชบริการ เมื่อเทคโนโลยีใหมๆ พัฒนาขึ้น ส่ือ
อิเล็กทรอนิกสและดิจิตอลสามารถแกไขปญหาในอดีตได ทําใหงานงายขึ้น การ
ผสมผสานเชื่อมโยงความรูและเทคนิคจากตางสาขากอใหเกิดประโยชนสูงสุดในงาน 
ดังเชน การนําความรูในงานถายภาพซึ่งเปนเทคโนโลยีทางการศึกษาประสานความรู
ทางเทคโนโลยีสารสนเทศ เกิดการแปลงสื่อดิจิทัลสําหรับงานหนังสือหายากครั้งน้ี 

2) การเชื่อมโยงและประสานระหวางสาขาวิชาไมเพียงปรากฏในการปฏิบตัิงาน แตยัง
ตองพัฒนาในระดับผูปฏิบัติงานดวย บรรณารักษและนักวิชาการโสตทัศนศึกษาไม
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เพียงตองรับตองานกัน หากตองทําความเขาใจในงานของกันและกัน การเรียนรูและ
ทําความเขาใจในงานที่แตกตางกัน กอใหเกิดภูมิรูในตัวตนของกันอีกสวนหนึ่งดวย 

 
4. เปนตนแบบของการพัฒนาหนังสือหายากอิเล็กทรอนิกสของศูนยวิทยทรัพยากร 

1) เม่ือศูนยวิทยทรัพยากรเริ่มโครงการทดลองหนังสือหายากอิเล็กทรอนิกสน้ัน (2546) 
ยังไมมีหนวยงานบริการสารสนเทศแหงใดจัดทําหนังสืออิเล็กทรอนิกสดวยตนเอง
มากนัก บางแหงที่ดําเนินการ ก็เปนการสแกนหนาหนังสือทั้งส้ิน ศูนยวิทยทรัพยากร
จึงเปนหนวยงานบริการแหงแรกที่ริเร่ิมจัดทําหนังสืออิเล็กทรอนิกสดวยการถายภาพ 
การเปนผูริเริ่มน้ัน มีทั้งขอดีและขอดอย ขอดีคือ การแสดงถึงศักยภาพในการเปนผูนํา
ดานการพัฒนาบริการสารสนเทศและการสรางนวัตกรรมงานเทคนิคและบริการ 
ขอดอย คือ การตองเรียนรูที่จะแกไขปญหาใหไดทันการณ เพ่ือใหงานไมไดรับ
ผลกระทบจากขอผิดพลาด งานถายภาพไมมีโอกาสลองผิด/ถูก  ทุกขั้นตอน
กระบวนงานตองวางแผนอยางรอบคอบ หากไมมั่นใจ ตองทดสอบนอกรอบ เพราะ
เม่ือลงมือปฏิบัติจริง หนังสือหายากเปนทรัพยากรสารสนเทศที่ไมอาจหาทดแทนได 
ตองไมใหเกิดความเสียหายกับตัวเลมโดยเด็ดขาด อยางไรก็ตามขอดอยน้ี สําหรับ
ผูปฏิบัติงานแลว ถือเปนโอกาสในการเรียนรูที่ดีย่ิง เพราะหากไมพบปญหาแลว ก็จะ
ไมเกิดความรู อันเปนเทคนิคที่เกิดจากการพัฒนางาน 

2) เม่ือโครงการฯนี้ส้ินสุดลงและมีการนําหนังสือหายากอิเล็กทรอนิกสขึ้นใหบริการและ
เผยแพรบน website ของศูนยวิทยทรัพยากรแลว  หนวยงานตางๆ จาํนวนมากสนใจ
ติดตอขอเขาชมและศึกษาการจัดทําหนังสือหายากอิเล็กทรอนิกส  ศูนยวิทยทรัพยากร
ไดช่ือวา เปนตนแบบการจัดทําหนังสืออิเล็กทรอนิกส สําหรับหนังสือเกาท่ีมีคุณคา 
และเปน ผูนําในการพัฒนางานหนังสืออิเล็กทรอนิกสท่ัวไป 

3 )    การอนุรักษหนังสือเกาในปจจุบันนี้ ในแงของการปฏิบัติงาน ผูปฏบิัติงานมีการ   
                                  ยอมรับระดับหน่ึงแลววา การใชกลองดิจิทัลที่มีความเหมาะสม และเปนเคร่ืองมือ     

ประกอบการถายภาพที่ดี  สามารถถายภาพหนังสือเกาได และไดไฟลภาพเปนหนา 
หนังสือ 1 หนาหนังสือ ตอ 1 ไฟลภาพ เม่ือนําไฟลภาพหลายๆ ไฟลมาตอกันก็คือ เลม 
หนังสือ  โดยนัยน้ี ในทางปฏิบัติก็สามารถทําหนาหนังสืออิเล็กโทรนิกสได และหลาย     
หนวยงานก็ไดเริ่มใชกลองดิจิทัลปฏิบัติงานในทํานองนี้แลว 

 
 
\ 
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ขอเสนอแนะเพื่อการดําเนินการขั้นตอไปของโครงการ 
 

โครงการตอไป : หนังสือหายากอิเล็กทรอนิกสประเภทเอกสารตนฉบับตัวเขียนสมุดไทย 
เมื่อโครงการนํารอง หนังสือหายากอิเล็กทรอนิกสไดรับผลสําเร็จเปนท่ีนาพอใจระดับหน่ึงแลว ผูเสนอ
ผลงานมีแนวคิดจะพัฒนาจากพื้นฐานความรูน้ีสูการจัดทําหนังสือหายากอิเล็กทรอนิกสประเภทเอกสาร
ตนฉบับตัวเขียนหรือสมุดไทยขาวและสมุดไทยดํา (สมุดไทยใบลาน)ตอไป เน่ืองจากศูนยวิทยทรัพยากร
เปนหน่ึงในแหลงทรัพยากรสารสนเทศประเภทเอกสารตนฉบับตัวเขียนที่ดีที่สุดแหลงหน่ึงของประเทศ 
นอกเหนือจากที่จัดเก็บและใหบริการที่หอสมุดแหงชาติ  แนวคิดที่จะใหงานโครงการหนังสือหายาก
อิเล็กทรอนิกสประเภทเอกสารตนฉบับตัวเขียนเปนอีกหนึ่งในนวัตกรรมเทคโนโลยีเพ่ืองานบริการ
ทรัพยากรสารสนเทศ เพ่ือวัตถุประสงคในการอนุรักษมรดกทางวรรณกรรมและคงคุณคางานบรกิารเพื่อ
การศึกษาคนควาน้ัน  มีตนแบบแนวคิดในการศึกษา (Model Profile) จากโครงการ Codex   
( http://www.codexsinaiticus.org/ ) ซ่ึงเปนงานอนุรักษตนฉบับไบเบิล ที่เขียนดวยลายมือที่เกาแกที่สุดใน
โลก เขียนเปนภาษากรีก มีอายุกวา 1600 ป คนพบ ณ วิหารเซนต แคทเทอรีน เมาทไซนาย โดยชิ้นสวนตางๆ 
ของเอกสารตนฉบับตัวเขียนของไบเบิลน้ีไดกระจัดกระจายอยูในความครอบครองขององคกรรัฐและเอกชน
ตางๆ กัน ถึง 4 แหง ไดแก หอสมุดแหงชาติอังกฤษ  หอสมุดมหาวิทยาลัยไลปซิก  หอสมุดแหงชาติรัสเซียที่
เซนตปเตอรสเบิรก และ วิหารเซนต แคทเทอรีน  ในป 2005  องคกรทั้งส่ีทําความรวมมือในการอนุรักษ 
จัดการถายภาพ  ถายโอนขอความและเผยแพรขอมูลจากเอกสารตนฉบับตัวเขียนดังกลาว ผานโครงงานวิจัย
พัฒนาหลายรูปแบบ  จนบังเกิดผลงานเปน 

เม่ือผูเสนอผลงานตัดสินใจนําแนวคิดจากงานนี้พัฒนาเปนโครงการตอเน่ือง ตองมีการประเมิน
ความเปนไปไดของโครงการฯ  ดวยการวิเคราะหขอมูลพ้ืนฐาน และการศึกษาขอมูลเพ่ิมเติมดานอุปกรณ 
เครื่องมือ เทคโนโลยีและวิธีการ เน่ืองจากเอกสารตนฉบับตัวเขียนสมุดไทย ทั้งสมุดไทยขาวและสมุดไทย
ดํามีลักษณะทางกายภาพที่แตกตางจากหนังสือหายากที่เคยดําเนินงานมากอน ตองพิจารณาเครื่องมือที่จะ
เหมาะสม  ศึกษาเทคนิควิธีที่เหมาะสม เพราะทั้งตัวแปรและปจจัยเปลี่ยนไป รวมท้ังตองศึกษาศักยภาพของ
เครื่องมือ หากไมพรอม อาจตองเตรียมแผนของบประมาณเพื่อจัดซ้ือกลองดิจิทัลและเลนสถายภาพตอไป 
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ตัวอยางการทดลองจัดทํา 
หนังสือหายากอิเล็กทรอนิกส ประเภทตนฉบับตัวเขียนสมุดไทยดําไทยขาว 

เร่ือง อนิรุทธ คําฉันท 
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ภาคผนวก 

ตนแบบการสรางขอมูลอิเล็กทรอนิกสของคัมภีรโบราณ (Bible) 
ดวยการถายภาพ  

The Codex Sinaiticus Project 
http://codexsinaiticus.org 
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Contact | Copyright  

 

• HOME  
• ABOUT CODEX SINAITICUS  
• ABOUT THE PROJECT  
• SEE THE MANUSCRIPT  

• GO TO: 
(Book)

 

Codex Sinaiticus  

Codex Sinaiticus is one of the most important books in the world. Handwritten well over 1600 years ago, 
the manuscript contains the Christian Bible in Greek, including the oldest complete copy of the New 
Testament. Its heavily corrected text is of outstanding importance for the history of the Bible and the 
manuscript – the oldest substantial book to survive Antiquity – is of supreme importance for the history 
of the book. [Find out more about Codex Sinaiticus.]  

The Codex Sinaiticus Project  

The Codex Sinaiticus Project is an international collaboration to reunite the entire manuscript in digital 
form and make it accessible to a global audience for the first time. Drawing on the expertise of leading 
scholars, conservators and curators, the Project gives everyone the opportunity to connect directly with 
this famous manuscript. [Find out more about the Codex Sinaiticus Project.]  

The Codex Sinaiticus Website  

This is the first release of the Codex Sinaiticus Project website. The fully developed website is online 
since July 2009. [Find out more about its current contents.]  

Partner institutions  

The British Library   

National Library of Russia   

St. Catherines Monastery   

Leipzig University Library   

RSSSupported by       
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Detail of scar tissue on Quire 78, folio 6 recto.  

Download the full image. 
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Participants 
Conservation 
Digital photography 
Transcription 
Website development 
Website presentation 
Contents of the current release 

The Codex Sinaiticus Project 
The Codex Sinaiticus Project has five principal activities:  

• historical research  
• conservation  
• digitisation  
• transcription  
• dissemination  

Historical research 
In order to clarify the circumstances under which Codex Sinaiticus came to be dispersed between the 
four institutions holding parts of the manuscript today, the project has undertaken new archival 
research to identify and study all relevant archival documents. The documents identified through this 
research are being used as the basis for a new account of the modern history of Codex Sinaiticus, to be 
agreed by all four partner institutions. The agreed account will be published on this website and in the 
project's printed publications. It will accompanied by transcripts or digital surrogates of the key archival 
documents wherever the permission of the owners can be secured. [More…] 

Conservation 
The conservation strategy for the Codex Sinaiticus Project was set out by its Conservation Working 
Party. An initial assessment of the manuscript's leaves in all four locations investigated how much work 
would be required to stabilise them before digitisation and to preserve them for the future. A detailed 
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assessment has been carried out in London, Leipzig and St Petersburg and is underway in St Catherine's 
Monastery. [More…] 

Digitisation 
Digitial photography of the geographically distributed leaves of Codex Sinaiticus is central to the 
Project's virtual reunification of the manuscript. Careful imaging of the original leaves provides a life-like 
view of the pages, thus allowing, for the first time, worldwide access to the manuscript. Images of every 
leaf were taken under evenly distributed ('standard') lighting for the main view of the manuscript. 
Images of every leaf have also been taken under raking light (i.e. lighting only from an angle) to 
emphasise the physical characteristics of the manuscript. [More…] 

Transcription 
A major research project which is led by the Institute for Textual Scholarship and Electronic Editing 
(ITSEE) at the University of Birmingham and funded by the UK's Arts and Humanities Research Council, 
has transcribed the texts of Codex Sinaiticus. The result is a uniquely detailed digital transcription of a 
Biblical codex. [More…] 

Dissemination 
The project has identified a range of products that will build upon the full scholarly reappraisal of the 
Codex and its texts and will also help to bring alive this iconic manuscript for everyone. The website is 
the main medium for making Codex Sinaiticus accessible. Other project outputs include a print facsimile, 
a conference, an exhibition and a popular book. [More…] 
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Lawrence Pordes, Juan Garcés and Ulrich Johannes Schneider (from left to right) in front of a digitisation 
cradle designed by Manfred Mayer at The British Library. (© Charlie Gray)  

Download the full image. 
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Website development 
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Website presentation 
Contents of the current release 

Digitisation 
One of the core undertakings of the project was to capture each page of Codex Sinaiticus as a high-
quality digital image. Each image offers a substitute for the real manuscript leaf. Careful imaging of 
Codex Sinaiticus therefore provides a life-like view of the pages and allows, for the first time, worldwide 
access to the manuscript. 

The digital photography of Codex Sinaiticus had to establish the best practice, taking into account that 

1. the leaves could not travel and had to be photographed at four different venues with different 
equipment;  

2. the writing on the leaves had to be readable on the digital images;  
3. the natural appearance of the parchment and ink had to be faithfully reproduced.  

Technical standards 
To make sure that the images produced were consistent, common standards and imaging practices were 
established across all venues by the Technical Standards Working Party. The recommendations 
included equipment (cameras, camera software, lighting, lenses, etc.) and processes (setup, colour 
profiling, etc.). 

Lighting 
When choosing the best lighting conditions for digitising Codex Sinaiticus, two aspects had to be 
carefully balanced. The writing on the leaves had to be readable on the digital images, to allow 
researchers to read and analyse it. At the same time, the natural appearance of the parchment and ink 
had to be faithfully reproduced, to allow the appreciation of the physical traits of Codex Sinaiticus. 

Different angles and levels of intensity were tested for the lighting, as the same set-up had to be used 
for every page. Since each page reflected the light at different angles, owing to the natural undulation of 
the parchment, a compromise had to be found to minimise this effect. Best results were achieved when 
the pages were lit at an angle of 45 degrees on low intensity without any backlighting. 

The parchment leaves of Codex Sinaiticus feature many marks on its surface - pricking holes, ruling 
indentations, as well as many other natural details - which are not easily visible with the 45 degree 
lighting directed from both sides of the page. The decision was therefore made to digitise each page 
twice, the second time with a light source at a low angle from a top corner. These are the 'raking light' 
images which optimise the view of the physical features of the parchment. 

Background 
The leaves of Codex Sinaiticus are so thin that the text from the other side of the page can show 
through when photographed. An appropriate background had to be used to lessen the show-through 
and at the same time to keep as true as possible to the colour of the parchment. 

Tests showed that white background paper allowed a relatively faithful representation of the parchment 
colour. The text, however, was often very hard to read because of the show-through from the text on 
the other side of the leaf. Black background paper, on the other hand, reduced the show-through 
considerably in tests and made the text more readable. The page, however, appeared too dark and the 
colours were not represented faithfully. 
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Test image of a Codex Sinaiticus page on a white 
background. 

Test image of a Codex Sinaiticus page on a black 
background. 

Through testing, the decision was made to opt for a compromise colour. A light brown background was 
chosen that was close enough to the colour of the parchment to give a sense of its warmth, while 
reducing the show-through to a point where it rarely makes reading the page difficult. 

 
See a list of the digitisation experts in the Codex Sinaiticus Project. 
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